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1. Introdução 

1.1 Objetivo 

O presente manual visa prestar apoio na utilização da aplicação informática ePIC, de modo a 
que os utilizadores da indústria cumpram as suas obrigações nos termos do Regulamento (UE) 
n.º 649/2012 do Parlamento Europeu e do Conselho, de 4 de julho de 2012, relativo à 
exportação e importação de produtos químicos perigosos, adiante designado como 
regulamento PIC. O manual descreve como enviar e acompanhar notificações de exportação (e 
as tarefas conexas), pedidos de RIN especial e comunicação de informação nos termos do 
artigo 10.º. 
 
O presente manual (Manual de Apresentação de Dados no ePIC) é adiante mencionado como 
MADE. Todos os manuais de apresentação da ECHA estão disponíveis no sítio Web da ECHA. 

1.2 Ícones, abreviaturas e terminologia 

O presente manual utiliza vários ícones e abreviaturas específicas. Os ícones são apresentados 
em áreas específicas do texto para realçar informações úteis ou importantes. 
 
No presente manual, são utilizados os seguintes ícones: 

 Informação útil, orientação, ajuda 

 Nota muito importante 

 
No presente manual, são utilizadas as seguintes abreviaturas: 

Código NC Código da Nomenclatura Combinada 

COM Comissão Europeia - DG Ambiente 

Código CUS Código do Inventário Aduaneiro Europeu das Substâncias Químicas 

AND Autoridade nacional designada 

ECHA Agência Europeia dos Produtos Químicos 

Código SH Código do sistema harmonizado 

EJ Entidade jurídica 

ANCC Autoridade nacional de controlo do cumprimento 

PIC Prévia informação e consentimento 

Regulamento PIC Regulamento (CE) n.º 649/2012 

RIN Número de identificação de referência 

FDS Ficha de dados de segurança 

http://echa.europa.eu/support/dossier-submission-tools/
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2. Princípios gerais 

2.1  O que é o ePIC? 

O ePIC é um sistema informático desenvolvido e mantido pela ECHA com o objetivo de garantir 
que os processos exigidos no âmbito do regulamento PIC sejam apoiados por um sistema 
informático adequado. O ePIC é constituído por três interfaces independentes: uma dedicada 
aos utilizadores da indústria, uma dedicada aos utilizadores das autoridades (atualmente, a 
ECHA, as autoridades nacionais designadas e a Comissão; num futuro próximo, também as 
autoridades nacionais de controlo do cumprimento) e uma dedicada aos utilizadores das 
autoridades aduaneiras. A aplicação facilita o intercâmbio seguro de informações entre os 
utilizadores da indústria e os utilizadores das autoridades.  

2.2 Interface para a indústria 

A interface do ePIC para a indústria garante a segurança do envio de dados e do intercâmbio 
de informações com os utilizadores das autoridades. Através desta interface, os utilizadores da 
indústria podem ver e atualizar os seus dados e controlar os seus envios. Os utilizadores da 
indústria podem iniciar sessão no ePIC e: 

• enviar notificações de exportação,  

• enviar pedidos de RIN especial (individuais e em grupo), 

• enviar os seus relatórios sobre as exportações e importações efetuadas durante o ano 
de calendário anterior (em conformidade com o artigo 10.º do Regulamento PIC), 

• gerir as suas misturas e artigos, 

• solicitar uma isenção (se aplicável),  

• ver o estado de notificações e pedidos de RIN especial enviados, 

• realizar tarefas atribuídas pelos utilizadores das autoridades (p. ex., reenvio de 
pedidos), 

• verificar se uma exportação específica pode ou não ser efetuada, 

• verificar se um país importador (não pertencente à UE) forneceu informações relativas 
à importação de determinados produtos químicos ou categorias de produtos químicos. 

2.3 Interface para as autoridades 

A interface do ePIC para as autoridades apoia o trabalho diário das autoridades no processo 
regulamentar. Através desta interface, os utilizadores das autoridades podem processar as 
suas tarefas e encaminhá-las para a ECHA ou para a Comissão, bem como comunicar de forma 
segura com os utilizadores da indústria. 

2.4 Interface para as autoridades aduaneiras 

A interface do ePIC para as autoridades aduaneiras é dedicada aos funcionários destas 
autoridades, fornecendo-lhes informações relativas aos dados e ao estado da exportação (p. 
ex., conteúdo, país de destino e se a exportação é ou não autorizada num determinado 
momento).  
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3. Página inicial para a indústria 

Depois de iniciar sessão na aplicação, é apresentada ao utilizador a «Home page» [Página 
inicial] (Figura 1). A página inicial é o ponto de partida para aceder a todas as tarefas. Fornece 
também uma descrição e fácil acesso aos RIN pendentes/ativos/inativos e às notificações que 
possam estar pendentes de reenvio.  
 
Figura 1: Página inicial do ePIC para a indústria 

 

A Página inicial pode ser dividida em quatro partes principais: 
 

• A secção central, com 7 mosaicos, apresenta o número de notificações de exportação e 
pedidos de RIN especial com estados diferentes. Esses mosaicos funcionam como 
atalhos para aceder às secções pertinentes da aplicação. Importa referir que o sétimo 
mosaico, que apresenta o número de relatórios pendentes nos termos do artigo 10.º, 
só estará disponível se o utilizador tiver um projeto de relatório no sistema. 

• Acima dos mosaicos, encontra-se o feed de notícias. O feed de notícias apresenta dois 
tipos de informações: notícias e alertas. Os alertas são apresentados numa caixa de 
mensagens vermelha e as notícias são apresentadas a azul. Na maior parte dos casos, 
os alertas são utilizados quando os exportadores devem adotar determinadas medidas, 
enquanto as notícias se destinam a fornecer informações genéricas. 

• O menu do lado esquerdo (também designado menu principal) funciona como um 
navegador da aplicação, a partir do qual é possível aceder à maioria das 
funcionalidades do ePIC. Contém ainda uma barra de «quick search» [pesquisa rápida], 
onde a introdução de um RIN ou de um ID de consentimento explícito/pedido de 
isenção devolve o resultado pertinente. 

• A barra da parte superior fornece uma ligação para o módulo «ECHA Accounts» [Contas 
ECHA]. Quando o utilizador é redirecionado para o módulo «ECHA Accounts» [Contas 
ECHA], é possível alternar entre diferentes utilizadores (desde que tenham contas em 
diferentes entidades jurídicas) para ver e editar as informações da Parte (se o utilizador 
também for um gestor do módulo Contas ECHA). Para mais informações sobre as 
Contas ECHA, consulte o respetivo manual de utilização, disponível no sítio Web da 
ECHA. 
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4. Criar e gerir misturas/artigos 

Para notificar uma exportação de misturas ou artigos, é necessário primeiro criar uma 
biblioteca dos seus artigos ou misturas. A seguir, é possível selecionar a mistura ou o artigo 
pretendido diretamente no formulário de notificação da exportação. As informações fornecidas 
durante a criação da mistura ou do artigo serão utilizadas para preencher automaticamente os 
campos pertinentes do formulário de notificação de exportação.  
 
As funcionalidades pertinentes do ePIC estão disponíveis no menu principal, na secção 
«Chemicals, Mistures & Articles» [Produtos químicos, misturas e artigos].  

4.1 Misturas 

4.1.1 Criar uma nova mistura 
Para adicionar uma nova mistura à sua biblioteca, clique na ligação «Create mixture» [Criar 
mistura] no menu principal (Figura 2).  

Figura 2: Funcionalidade Criar nova mistura 

 
 
É aberta uma nova página com o título «Mixture» [Mistura] (Figura 3). O formulário é 
constituído por três secções, com o separador «Summary» [Resumo] apresentado por 
predefinição.  
 
Os campos obrigatórios estão assinalados com um asterisco .  
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Figura 3: Ecrã Criar mistura 

 
 
4.1.2 Separador Resumo  
O primeiro separador contém campos para a introdução de informações relativas à 
identificação e classificação da mistura. Os campos seguintes estão disponíveis e os títulos com 
um asterisco referem-se a campos obrigatórios: 
 

• «Name*» [Nome*]: nome da mistura  
• «CN code*» [Código NC*]: código da Nomenclatura Combinada da mistura  
• «CUS code» [Código CUS]: identificador da mistura no Inventário Aduaneiro Europeu 

das Substâncias Químicas (se disponível) 
• «HS code» [Código SH]: código da mistura no Sistema Harmonizado (se disponível) 
• «Alias» [Nome alternativo]: tem a possibilidade de indicar um nome alternativo para 

a sua mistura. Se este campo estiver vazio, será publicado o nome verdadeiro da 
mistura no sítio Web da ECHA 

• «Hazard classification*» [Classificação de perigo*]: classificação de perigo da 
mistura.  

 A indicação de uma referência à ficha de dados de segurança anexada não é aceite 
no campo «Hazard classification» [Classificação de perigo] do processo «Create 
mixture» [Criar mistura]. Neste campo, devem ser introduzidas informações 
detalhadas sobre a classificação da mistura. 

Depois de preencher os campos acima, navegue para o separador seguinte. 
 
4.1.3 Produtos químicos do anexo I  
Neste separador (Figura 4), deve selecionar os produtos químicos constantes do anexo I e 
indicar a sua concentração na mistura; os dois campos são obrigatórios. Clique em «Add» 
[Adicionar] depois de preencher o formulário. 
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Se a sua mistura contiver vários produtos químicos constantes do anexo I, deve repetir os 
passos acima para cada um deles.  
 

 Caso pretenda criar uma mistura que contenha um elemento de grupo (p. ex., 
pentóxido de diarsénio, CAS 1303-28-2), deve selecionar a entrada do grupo (p. 
ex., compostos de arsénio) na lista pendente e especificar a substância exata, 
indicando o número CAS ou o número CE. 

 
Figura 4: Separador Produtos químicos do anexo I 

 
 

 
Para editar um produto químico que faz parte da composição, clique no ícone de 
lápis. 

 Para eliminar um produto químico da composição, clique no ícone «X» (visível 
apenas se forem indicados na composição vários produtos químicos constantes do 
anexo I). Uma mistura deve conter sempre, pelo menos, um produto químico. 
Assim, é necessário adicionar um novo antes de eliminar o existente. 

 
Clique em «Next section» [Secção seguinte] e será encaminhado para o separador «SDS» 
[FDS]. 
 
4.1.4 Separador FDS 
O separador FDS (Figura 5) permite anexar uma ou várias fichas de dados de segurança à sua 
mistura. Os documentos anexados serão automaticamente incluídos nas notificações de 
exportação elaboradas para esta mistura.  
 

 Se não anexar uma FDS à sua mistura, não poderá fazê-lo ao criar uma notificação 
de exportação para esta mistura.  

Caso seja necessário adicionar outras FDS à sua mistura numa etapa posterior, 
poderá fazê-lo através da funcionalidade «Manage mixture» [Gerir mistura]. 
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Figura 5: Separador FDS 

 
 
Selecione o idioma do documento no menu pendente e clique em «Browse» [Pesquisar]. 
Localize o ficheiro no seu computador através da janela de pop-up.  
 

 Recomenda-se vivamente o carregamento de uma FDS em inglês, se existir, uma 
vez que facilita o processamento da notificação pela sua autoridade nacional 
designada e pela ECHA. 

 
Depois de anexar todos as fichas de dados de segurança necessárias, escreva o código de 
segurança e clique em «Upload» [Carregar]. Caso não seja facilmente legível, prima o botão 
«get new code» [obter novo código] para solicitar um novo código. Para anexar a(s) ficha(s) 
de dados de segurança à sua mistura, clique em «Upload» [Carregar]. 
 

 O sistema substituirá um ficheiro existente se carregar um novo ficheiro num 
idioma já armazenado. 

 
4.1.5 Botões «Save & Close» [Guardar e fechar], «Save» [Guardar] e 
«Cancel» [Cancelar] 
Depois de preencher todas as informações necessárias, lembre-se de guardar a sua mistura, a 
fim de criar um novo registo. 
 

 Guarda o registo, valida se todos os dados obrigatórios estão disponíveis e 
volta a colocar o utilizador no modo de visualização. 
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 Guarda o registo e valida se todos os dados obrigatórios estão disponíveis. 
Caso existam erros, os campos incorretos são realçados a vermelho com 
mensagens de erro. 

 Cancela as entradas de dados atuais sem guardar e regressa à página 
inicial. 

4.1.6 Pesquisar misturas 
Para ver e editar as suas misturas já criadas, clique na ligação «Manage mixtures» [Gerir 
misturas] (Figura 6) no menu principal.  

Figura 6: Ligação Gerir misturas 

 
 
Para visualizar todas as suas misturas, selecione a caixa de verificação «Mixture» [Mistura] e 
clique em «Search» [Pesquisar] (Figura 7). 
 
Figura 7: Ecrã Pesquisar mistura/artigo 

 

 
Todas as misturas que criou são apresentadas nos resultados de pesquisa (Figura 8). 
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Figura 8: Resultados de pesquisa 

 

Também pode pesquisar pelo nome da mistura ou pelo(s) produto(s) químico(s) constantes do 
anexo I que esta contém. A lista de resultados será mais curta e mais precisa. Para pesquisar 
pelo nome da mistura, introduza, pelo menos, os primeiros carateres do nome no campo 
«Name» [Nome] e clique em «Search» [Pesquisar].  
Para pesquisar uma mistura pelo produto químico constante do anexo I nela contido, selecione 
o produto químico na lista pendente (Figura 9). 
 
Figura 9: Pesquisar por nome/produto químico do anexo I 

 

Para ver os detalhes de uma mistura, clique no nome da mistura apresentado na coluna 
«Mixture / Article name» [Nome mistura/artigo] dos resultados da pesquisa.  

4.1.7 Editar mistura 
Se necessitar de atualizar as informações relativas a uma mistura, selecione «Manage 
mixtures» [Gerir misturas]. O sistema alertá-lo-á se existir uma notificação cujo estado seja 
«draft» [projeto] ou «pending resubmission» [pendente de reenvio] e que faça referência à 
mistura que pretende editar. As alterações aplicadas à mistura antes do envio da notificação 
de exportação serão automaticamente refletidas no próprio formulário de notificação.  

Clique na ligação «Manage mixtures» [Gerir misturas] (Figura 6) no menu principal.  

Pesquise a mistura que pretende editar e clique no nome da mistura (Figura 10). (O capítulo 
4.1.6 descreve várias formas de encontrar misturas já criadas). 
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Figura 10: Pesquisar resultados - misturas 

 
 
Quando abrir a mistura que pretende editar, esta estará no modo só de leitura por 
predefinição. Clique em «Edit» [Editar] para aplicar as alterações (Figura 11). 
 
Figura 11: Editar mistura 

 
 
Todos os dados podem ser modificados; os capítulos 4.1.2, 4.1.3 e 4.1.4 contêm informações 
sobre como preencher os campos. 

 Lembre-se de que as alterações são ignoradas, a menos que clique em «Save & 
Close» [Guardar e fechar] ou em «Save» [Guardar]. 

 O registo de uma mistura só pode ser eliminado se não tiver sido referenciado 
numa notificação de exportação ou num pedido de RIN especial. 

4.2 Artigos 

 As notificações de artigos só são necessárias no caso de produtos químicos 
enumerados nas partes 2 ou 3 do anexo I do Regulamento PIC. 
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4.2.1 Criar um novo artigo 
Para adicionar um novo artigo à sua biblioteca, clique na ligação «Create article» [Criar artigo] 
no menu principal (Figura 12).  

Figura 12: Funcionalidade Criar novo artigo 

 
 
É aberta uma nova página com o título «Article» [Artigo] (Figura 13). O formulário é 
constituído por três secções, com o separador «Summary» [Resumo] apresentado por 
predefinição.  
 
Os campos obrigatórios estão assinalados com um asterisco .  
 
Figura 13: Ecrã Criar artigo 

 
 
4.2.2 Separador Resumo  
O primeiro separador (Figura 13) contém campos para a introdução de informações relativas à 
identificação e classificação do artigo. Os campos seguintes estão disponíveis e as informações 
obrigatórias estão assinaladas com um asterisco: 
 

• «Name*» [Nome*]: Nome do artigo  
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• «CUS code» [Código CUS]: identificador da mistura no Inventário Aduaneiro Europeu 
das Substâncias Químicas (se disponível) 

• «Alias» [Nome alternativo]: tem a possibilidade de indicar um nome alternativo para 
o seu artigo. Se este campo estiver vazio, será publicado o nome verdadeiro do artigo 
no sítio Web da ECHA 

• «Hazard classification*» [Classificação de perigo*]: Classificação de perigo do 
produto químico constante do anexo I utilizado no seu artigo  

 
Depois de preencher os campos acima, navegue para o separador seguinte. 
 
4.2.3 Produtos químicos do anexo I  
Neste separador (Figura 14), deve selecionar os produtos químicos constantes do anexo I e 
indicar a sua concentração no artigo. Os dois campos são obrigatórios. Depois de fornecer as 
informações necessárias, clique em «Add» [Adicionar]. 
 
Se o seu artigo contiver vários produtos químicos constantes do anexo I, deve repetir os 
passos acima para cada uma deles.  
 

 Caso pretenda criar um artigo que contenha um elemento de grupo (p. ex., 
pentóxido de diarsénio, CAS 1303-28-2), deve selecionar uma entrada de grupo 
(p. ex., compostos de arsénio) na lista pendente e especificar a substância exata, 
indicando o número CAS ou o número CE. 

 
Figura 14: Separador Produtos químicos do anexo I 

 
 

 
Para editar a composição, clique no ícone de lápis. 

 Para eliminar um produto químico da composição, clique no ícone «X» (visível 
apenas se estiverem enumerados na composição vários produtos químicos 
constantes do anexo I). Um artigo deve conter sempre, pelo menos, um produto 
químico. Assim, é necessário adicionar um novo antes de eliminar o existente. 

 
Clique em «Next section» [Secção seguinte] e será encaminhado para o separador «SDS» 
[FDS]. 
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4.2.4 Separador FDS 
O separador FDS (Figura 15) permite anexar uma ficha de dados de segurança ao seu artigo. 
Os documentos anexados serão automaticamente incluídos nas notificações de exportação 
elaboradas para este artigo.  
 

 Tenha em atenção que se não anexar uma FDS ao seu artigo, não poderá fazê-lo 
ao criar uma notificação de exportação para este artigo.  

Caso seja necessário adicionar outras FDS ao seu artigo numa etapa posterior, 
poderá fazê-lo através da funcionalidade «Manage article» [Gerir artigo]. 

Figura 15: Separador FDS 

 
 
Selecione o idioma do documento no menu pendente e clique em «Browse» [Pesquisar]. 
Localize o ficheiro no seu computador através da janela de pop-up. 
 

 Recomenda-se vivamente o carregamento de uma FDS em inglês, se existir, uma 
vez que facilita o processamento da notificação de exportação pela sua autoridade 
nacional designada e pela ECHA. 
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Depois de anexar todos as fichas de dados de segurança necessárias, escreva o código de 
segurança e clique em «Upload» [Carregar]. Caso não seja facilmente legível, prima o botão 
«get new code» [obter novo código] para solicitar um novo código. Para anexar a(s) ficha(s) 
de dados de segurança ao seu artigo, clique em «Upload» [Carregar]. 
 

 O sistema substituirá um ficheiro existente se carregar um novo ficheiro num 
idioma já disponível. 

 
4.2.5 Botões «Save & Close» [Guardar e fechar], «Save» [Guardar] e 
«Cancel» [Cancelar] 
Depois de preencher todas as informações necessárias, lembre-se de guardar o seu artigo, a 
fim de criar um novo registo. 
 

 Guarda o registo, valida se todos os dados obrigatórios estão disponíveis e 
volta a colocar o utilizador no modo de visualização. 

 Guarda o registo e valida se todos os dados obrigatórios estão disponíveis. 
Caso existam erros, os campos incorretos são realçados a vermelho com 
mensagens de erro. 

 Cancela as entradas de dados atuais sem guardar e regressa à página 
inicial. 

4.2.6 Procurar artigos 
Para ver e editar os seus artigos já criados, clique na ligação «Manage articles» [Gerir artigos] 
(Figura 16) no menu principal.  

Figura 16: Ligação Gerir artigos 

 

 
Para visualizar todas os seus artigos, selecione a caixa de verificação «Article» [Artigo] e clique 
em «Search» [Pesquisar] (Figura 17). 
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Figura 17: Ecrã Pesquisar Mistura/Artigo 

 

 
Todos os artigos que criou são apresentados nos resultados de pesquisa (Figura 18). 

Figura 18: Resultados de pesquisa 

 

Também pode pesquisar pelo nome do artigo ou pelo(s) produto(s) químico(s) constantes do 
anexo I que este contém. A lista de resultados será mais curta e mais precisa. Para pesquisar 
pelo nome do artigo, introduza, pelo menos, os primeiros carateres do nome no campo 
«Name» [Nome] e clique em «Search» [Pesquisar].  
Para procurar um artigo pelo produto químico constante do anexo I nele contido, selecione o 
produto químico na lista pendente e clique em «Search» [Pesquisar] (Figura 19). 
 
Figura 19: Pesquisar por nome/produto químico do anexo I 

 

Para ver os detalhes de um artigo, clique no nome do artigo apresentado na coluna «Mixture / 
Article name» [Nome mistura/artigo] dos resultados da pesquisa.  
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4.2.7 Editar artigo 
Se necessitar de alterar informações relativas a artigo(s) já criado(s), selecione «Manage 
articles» [Gerir artigos]. O sistema alertá-lo-á, se existir uma notificação cujo estado seja 
«draft» [projeto] ou «pending resubmission» [pendente de reenvio] e que faça referência ao 
artigo que pretende editar. As alterações aplicadas ao artigo antes do envio da notificação de 
exportação serão automaticamente refletidas no próprio formulário de notificação.  

Primeiro, clique na ligação «Manage article» [Gerir artigo] (Figura 16) no lado esquerdo do 
menu.  

Procure o artigo que pretende editar e clique no nome do artigo (Figura 20). (O capítulo 4.1.6 
descreve várias formas de encontrar artigos criados anteriormente). 
 
Figura 20: Pesquisar resultados - artigos 

 
 
Quando abrir o artigo que pretende editar, este estará no modo só de leitura por predefinição. 
Clique em «Edit» [Editar] para aplicar as alterações (Figura 21). 
 
Figura 21: Editar artigo 

 
 
Todos os dados podem ser modificados; os capítulos 4.2.2, 4.2.3 e 4.2.4 contêm informações 
sobre como preencher os campos.  
 

 Lembre-se de que as alterações são ignoradas, a menos que clique em «Save & 
Close» [Guardar e fechar] ou em «Save» [Guardar]. 
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 O registo de um artigo só pode ser eliminado se não tiver sido referenciado numa 
notificação de exportação ou num pedido de RIN especial. 
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5. Criar notificação de exportação  

5.1 Notificação de exportação para um produto químico 

Para criar uma notificação de exportação para um produto químico, clique na ligação 
«Notification for chemical» [Notificação para um produto químico]  
(Figura 22) no menu principal.  
 
Figura 22: Ecrã Criar notificação de exportação para um produto químico 

 
É apresentada uma nova página «Export notification for a chemical» [Notificação de 
exportação para um produto químico], constituída por seis separadores. Em todas as secções, 
é visível uma área comum situada na parte superior do ecrã (Figura 23) que apresenta as 
informações relativas ao país importador, bem como os botões «Save» [Guardar], «Submit» 
[Enviar] e «Cancel» [Cancelar]. 
 
A «Section 1» [Secção 1] é apresentada por predefinição quando a notificação de exportação é 
aberta.  
 

 Os campos obrigatórios estão assinalados com um asterisco  em todo o 
formulário. 

Figura 23: Área comum  

 
 
Selecione o país importador no menu pendente. (Figura 23) 
 
5.1.1 Secção 1: Identidade do produto químico a que se refere a notificação 
de exportação 
A «Section 1» [Secção 1] contém os seguintes campos: 
 
«Common name» [Nome comum]: selecione o seu produto químico na lista pendente, que 
inclui todos os produtos químicos constante do anexo I. Este campo é obrigatório, a menos 
que indique um número CE ou um número CAS.  
 

 Se a substância a exportar estiver incluída numa entrada de grupo, é obrigatório 
especificar um número CAS ou um número CE em vez da entrada genérica do 
grupo. Por exemplo, se pretender exportar brometo de arsénio (incluído no grupo 
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«Compostos de arsénio»), não pode identificar a substância como compostos de 
arsénio e deve indicar o número CAS (64973-06-4) ou o número CE (265-296-8). 
 

Uma vez identificado o produto químico, os números de código nas secções 1.3.1, 1.3.2, 1.3.3 
e 1.3.4 serão preenchidos automaticamente pelo sistema (se existirem). A área comum na 
parte superior do formulário apresentará informações respeitantes à parte do anexo I a que a 
substância pertence (Figura 24).  
 
«Chemical name according to internationally recognised nomenclature (e.g. IUPAC)» 
[Denominação química de acordo com a nomenclatura reconhecida 
internacionalmente (p. ex, IUPAC)]: se disponível, indique o nome do produto químico 
constante do anexo I utilizado. 
 
«CAS number & EC number» [Número CAS e número CE]: obrigatório no caso de 
exportações de produtos químicos incluídos numa entrada de grupo (p. ex., compostos de 
tributilestanho). Se o sistema reconhecer o número CAS ou número CE, efetuará o 
preenchimento automático do campo «Common name» [Nome comum].  
 

 Ao fornecer um número CAS ou CE específico de uma substância incluída numa 
entrada de grupo, não selecione o grupo genérico na lista pendente da secção 
«Common name» [Nome comum]. 

 
«Harmonized system customs code» [Código do sistema de classificação 
harmonizado alfandegário]: se o código SH do produto químico exportado existir no 
sistema, este campo será preenchido automaticamente. Compete sempre ao exportador 
verificar se a informação está atualizada e alterá-la, se necessário. 
 
«CN code» [Código NC]: se existir no sistema um código NC do produto químico exportado, 
este campo será preenchido automaticamente. Tenha em atenção que o código NC poderá não 
estar disponível e a ECHA não pode garantir que o código fornecido é o mais atualizado. 
Compete sempre ao exportador verificar esta informação e alterá-la, se necessário. 
 
«CUS code» [Código CUS]: o código CUS é obrigatório para as substâncias e misturas às 
quais foi atribuído um código CUS. O código CUS poderá não estar disponível e a ECHA não 
pode garantir que o código fornecido é o mais atualizado. Compete sempre ao exportador 
verificar esta informação e alterá-la, se necessário.  
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Figura 24: Secção 1  

 
 
«Other numbers» [Outros números]: se pretender utilizar mais identificadores, utilize a 
primeira coluna para o sistema numérico e a segunda para os dados. 
 
5.1.2 Secção 3: Informação relativa à exportação:  
«Expected date of first export*» [Data prevista da primeira exportação*]: introduza a 
data prevista da exportação manualmente ou através do calendário. A data da exportação não 
pode ser anterior a mais de 35 dias da data de envio da notificação.  
 
«Caixa de verificação Emergency Situation» [Situação de emergência]: deve ser 
selecionada, se o produto químico estiver relacionado com uma situação de emergência em 
que um atraso possa colocar em perigo a saúde pública ou o ambiente. É apresentado um 
campo de justificação obrigatório1 por baixo da caixa de verificação a fim de obter o RIN 
especial, necessário para este tipo de exportação. 
 
«Expected yearly amount of the substance/mixture*» [Quantidade anual prevista da 
substância/mistura*]: introduza a quantidade anual prevista do produto químico que será 
exportada e selecione a unidade (kg/l) na lista pendente. Só é possível utilizar um ponto (.) 
como ponto decimal e só é permitido um máximo de três casas decimais depois do ponto.  
 
 

                                           
 
1 Pode ser concedida uma isenção da obrigação de notificar no prazo de 35 dias antes da data prevista de exportação, 
mediante pedido fundamentado do exportador, da Parte ou de outro país importador, nos casos em que a exportação 
do produto químico esteja relacionada com uma situação de emergência em que um atraso possa colocar em perigo a 
saúde pública ou o ambiente na Parte importadora ou noutro país importador.  (artigo 8.º, n.º 5, do Regulamento (UE) 
n.º 649/2012). 
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«Foreseen category in importing country*» [Categoria prevista no país 
importador*]: indique a categoria de utilização prevista no país importador, selecionando 
a(s) caixa(s) de verificação pertinente(s). Forneça a informação sobre as utilizações previstas 
no(s) campo(s) de texto livre.  
 

 Recomenda-se que a descrição da utilização pretendida seja tão exata quanto 
possível, em especial se for necessária uma autorização explícita para a 
exportação, uma vez que esta informação ajuda a autoridade nacional designada 
do país importador a tomar uma decisão. 

 
«Importer name, address, telephone, fax and e-mail*» [Nome, telefone, fax e e-mail 
do exportador*]: clique no botão «+ Manage importers» [+ Gerir importadores] para 
selecionar a(s) empresa(s) importadora(s) para esta notificação de exportação. Para selecionar 
os importadores pertinentes, assinale a caixa de verificação na coluna «Actions» [Ações] 
(Figura 25). Se a lista de empresas apresentada estiver vazia, é necessário adicionar uma 
nova empresa. O capítulo 5.1.2.1 contém informações adicionais sobre como adicionar uma 
nova empresa. É obrigatório indicar, pelo menos, um importador. 
 
Figura 25: Selecionar exportador 

 
 

 O botão «+ Manage importers» [+ Gerir importadores] só está disponível depois 
de selecionar um país importador. 

 É possível especificar mais do que um importador, se necessário. Neste caso, os 
importadores pertinentes devem ser adicionados à base de dados e selecionados. 

 As informações relativas ao exportador são preenchidas automaticamente a partir 
do módulo «Contas ECHA». Pode alterar as informações relativas ao telefone, fax e 
e-mail, se pretender mencionar um contacto/pessoa específicos nesta notificação 
de exportação (Figura 26). O endereço da Parte só pode ser modificado 
centralmente (por um utilizador que também seja gestor do módulo «Contas 
ECHA») através da ligação disponível. 

 
Figura 26: Informação relativa ao exportador no ePIC 

 
 
5.1.2.1 Codificação das informações de contacto de um parceiro de negócio no ePIC 
No ePIC, os parceiros de negócio são armazenados numa base de dados de empresas 
específica. Os exportadores e os importadores são armazenados em conjunto e agrupados por 
país. 

A lista de empresas pode ser gerida durante a criação de uma nova notificação de exportação 
ou de um RIN especial ou durante a revisão do relatório anual nos termos do artigo 10.º. A 
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base de dados pode ser acedida de várias formas: 

• Notificações de exportação: os exportadores podem ser acedidos através do botão 
«Manage Importers» [Gerir importadores] na secção 3.4.  

• Pedidos de RIN especial: os exportadores podem ser acedidos através do botão 
«Manage Importers» [Gerir importadores] no separador «Export Information» 
[Informação sobre a exportação].  

• Relatório do artigo 10.º: Clique no ícone de lápis na coluna «Exporters/Importers» 
[Exportadores/Importadores] 

Quando o utilizador está na secção dedicada do ePIC (Figura 27), o sistema apresenta a lista 
de parceiros de negócio no país a que se destina a notificação de exportação/o RIN especial. 
Se a lista estiver vazia ou não incluir o parceiro de negócio em causa, o utilizador pode 
adicionar um novo registo de empresa através do botão «+ New company» [+ Nova empresa] 
(Figura 28). 

Figura 27: Gerir parceiros de negócio 

 

Figura 28: Adicionar novo parceiro de negócio 

 
É apresentado um formulário de pop-up, no qual devem ser introduzidas as informações de 
contacto do parceiro de negócio. Utilize o botão «Save» [Guardar] para armazenar as 
informações na base de dados.  
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Figura 29: Codificar um novo parceiro de negócio 

 

Para gerir as informações de contacto, clique no ícone de lápis na coluna «Actions» [Ações]. 
Para eliminar uma informação de contacto, o utilizador deve clicar no ícone «X» na coluna 
«Actions» [Ações]. 

5.1.3 Secção 4: Informações relativas aos perigos e/ou riscos do produto 
químico e medidas preventivas  
Ao preencher a secção 4, tem duas opções: 
 

• Se pretender anexar uma ficha de dados de segurança à notificação de exportação, o 
preenchimento dos campos 4.1, 4.2, 4.3 e 4.4 não é obrigatório. Assinale a caixa de 
verificação «I will attach a copy of the safety data sheet that covers the information 
required below in section attachments» [Anexarei abaixo, nos anexos da secção, uma 
cópia da ficha de dados de segurança que abrange as informações solicitadas]; a 
secção 4.5 é preenchida automaticamente com «Safety Data Sheet» [Ficha de dados 
de segurança] e as secções 4.1, 4.2, 4.3 e 4.4 tornam-se opcionais. 

• Se não for anexada uma ficha de dados de segurança à notificação de exportação, as 
secções 4.1, 4.2, 4.3 e 4.4 devem ser preenchidas com as informações pertinentes 
relativas à gestão do perigo e dos riscos (as secções 4.1, 4.2, 4.3 e 4.4 são campos 
obrigatórios e a secção 4.5 é opcional).  
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Figura 30: Secção 4  

 
 
5.1.4 Secção 5: Informação relativa às propriedades físico-químicas, 
toxicológicas e ecotoxicológicas do produto químico 
Os requisitos de dados na secção 5 dependem de anexar ou não uma FDS à notificação de 
exportação (tal como na secção 4). Se não anexar uma ficha de dados de segurança, o campo 
5.1 é obrigatório. 
 
Se declarou na secção 4 que forneceria uma ficha de dados de segurança, o campo 5.2 é 
obrigatório e é preenchido automaticamente por predefinição com «Safety data sheet» [Ficha 
de dados de segurança] (Figura 31). 
 
Figura 31: Campos obrigatórios na secção 5 
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5.1.5 Secção 6: Informação resumida sobre a medida regulamentar final 
adotada pelo país exportador 
«Summary of and reasons for the final regulatory action and date of entry into 
force*» [Resumo e motivos da medida regulamentar final e data de entrada em 
vigor*]: forneça o resumo das restrições regulamentares e a respetiva justificação. Em 
alternativa, pode utilizar as informações do ePIC, clicando nos botões «English» [Inglês], 
«French» [Francês] ou «Spanish» [Espanhol], em conformidade com o requisito de idioma no 
país importador (Figura 32). Se esta informação ainda não estiver disponível no ePIC, o botão 
não estará ativo e deve procurar assistência junto da sua autoridade nacional designada.  
 

 Se a informação regulamentar estiver disponível apenas em inglês, pode ser 
utilizada independentemente do requisito de idioma no país importador. 

 
Figura 32: Medida regulamentar final 

 
 
Depois de selecionar o idioma adequado para a informação regulamentar, o texto jurídico será 
apresentado numa janela de pop-up. Clique no botão «Update» [Atualizar] e o texto será 
copiado para o campo 6.1. 
 
«The final regulatory action has been taken for the category*» [A medida 
regulamentar final foi adotada para a categoria*]: estas caixas de verificação indicam se 
a restrição regulamentar existente na UE foi introduzida para a categoria de utilização como 
pesticida ou como produto químico industrial. A informação é preenchida automaticamente 
com base no produto químico selecionado.  
 
«Prohibited uses/Allowed uses» [Utilizações proibidas/Utilizações autorizadas]: pelo 
menos, um dos campos de texto livre deve ser preenchido com a informação pertinente 
(máximo de 500 carateres).  
 
«Produced/Imported/Exported/Used» Produzido/Importado/Exportado/Utilizado]: 
indique uma estimativa, se estiver disponível, das quantidades anuais para o produto químico 
a que se refere a notificação de exportação.  
 
«Reference to the regulatory document» [Referência ao ato regulamentar]: indique 
uma referência a qualquer ato regulamentar que seja pertinente para a notificação de 
exportação.  
 
5.1.6 Anexos 
Pode utilizar a opção «Attach new documents» [Anexar novos documentos] para carregar a 
ficha de dados de segurança ou outros documentos de apoio pertinentes. 
 
Selecione o tipo de documento na primeira coluna e, depois, selecione o idioma na lista 
pendente e clique em «Browse» [Pesquisar]. Pode pesquisar o ficheiro a partir de uma janela 
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de pop-up.  
 
Por predefinição, o sistema permite carregar até três ficheiros. Se necessitar de mais, utilize o 
botão «Attach more documents...» [Anexar mais documentos...].  
 
Depois de selecionar o(s) documento(s) que pretende carregar, escreva o código de segurança 
e clique em «Upload» [Carregar]. Caso não seja facilmente legível, prima o botão «get new 
code» [obter novo código] para solicitar um novo código. Para anexar o(s) documento(s) à sua 
notificação, clique em «Upload» [Carregar]. 
 

 Recomenda-se vivamente o carregamento de uma FDS em inglês, se existir, uma 
vez que facilita o processamento da notificação pela sua autoridade nacional 
designada e pela ECHA. 

 

 O sistema substituirá um ficheiro existente se carregar um novo ficheiro num 
idioma já disponível. 

 
5.1.7 Botões «Save & Close» [Guardar e fechar], «Save» [Guardar], 
«Submit» [Enviar] e «Cancel» [Cancelar] 
Depois de fornecer todas as informações solicitadas, as opções seguintes estão disponíveis na 
parte superior da notificação.   
 

 
Guarda o registo e valida se todos os campos obrigatórios foram 
preenchidos. Caso existam erros, os campos incorretos são realçados a 
vermelho com mensagens de erro. 

 
Guarda o registo, valida se todos os campos obrigatórios foram 
preenchidos e volta a colocar o utilizador no modo de visualização. 

 
Guarda o registo, valida todos os campos obrigatórios e avança para a 
página de envio. 

 
Cancela as entradas de dados atuais sem guardar e regressa à página 
inicial. 

 
5.2 Notificações de exportação para misturas/artigos 

Para poder criar uma notificação de exportação para uma mistura ou um artigo, tem de criar 
primeiro a sua mistura ou o seu artigo. Ver capítulo 4, Criar e gerir misturas/artigos. As 
informações fornecidas na sua mistura/no seu artigo serão refletidas automaticamente nos 
campos pertinentes do formulário de notificação. 
 

 A criação de uma notificação de exportação para uma mistura/um artigo é muito 
idêntica à relativa a um produto químico. Neste capítulo, serão indicadas as 
diferenças. 

 
Para criar uma notificação, selecione «Notification for mixture» [Notificação para mistura] ou 
«Notification for article» [Notificação para artigo] (Figura 33) no menu principal. 
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Figura 33: Criar notificação de exportação para uma mistura 

 
O formulário é constituído por seis separadores e uma área comum na parte superior e fornece 
as informações relativas ao país importador, bem como os botões «Save» [Guardar], 
«Submit» [Enviar] e «Cancel» [Cancelar]. A secção 2 é apresentada por predefinição e as 
secções 3, 4, 5 e 6 são as mesmas que as da notificação de exportação para um produto 
químico (ver o capítulo 5.1 para mais informações). 

 Os campos obrigatórios do formulário estão assinalados com um asterisco . 

 
Para começar a preencher a sua notificação, selecione o país importador na lista pendente da 
área comum.  
 
5.2.1 Secção 2: Identidade da mistura/do artigo a exportar 
Selecione a mistura/o artigo na lista pendente que contém todas as misturas/todos os artigos 
que adicionou ao sistema. 
 
Os campos 2.2, 2.3 e 2.4 e o quadro «Concentration and information of substance(s)» 
[Concentração e informação da(s) substância(s)] são preenchidos automaticamente pelo 
sistema depois de selecionar a mistura/o artigo. 
 
5.2.2 Anexos 
O quadro «List of documents attached» [Lista de documentos anexados] apresenta todos os 
documentos, incluindo a ficha de dados de segurança carregada para a sua mistura/o seu 
artigo, com a versão inglesa (se disponível) selecionada automaticamente por predefinição. 
Para selecionar outras versões linguísticas da ficha de dados de segurança, selecione as caixas 
de verificação na coluna «Action» [Ação].  
 
Se faltar uma versão linguística, ou o ficheiro existente não estiver atualizado, pode adicionar 
a ficha de dados de segurança (ou substituir a existente), editando a mistura/o artigo nas 
secções «Manage mixtures» [Gerir misturas] ou «Gerir artigos] do ePIC. 
 

 As alterações devem ser todas guardadas antes de sair da página 

 
Quando regressar ao projeto de notificação de exportação depois de atualizar a mistura/o 
artigo, o sistema fornecerá automaticamente os últimos dados introduzidos, incluindo os 
anexos. 
 
Para carregar outros documentos (além da FDS) selecione, no separador «Attachments» 
[Anexos], o tipo de documento e o idioma e procure o ficheiro a anexar.  
 
Escreva o código de segurança ou, se o código não for facilmente legível, solicite um novo e 
prima o botão «Upload» [Carregar]. 
 

 Recomenda-se que anexe à mistura/ao artigo uma FDS em inglês, se esta estiver 
disponível. 
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6. Enviar notificações de exportação 

Clique no botão verde «Submit» [Enviar] na área comum na parte superior do formulário 
(Figura 34). 

Figura 34: Enviar notificações de exportação 
 

 

6.1 Projeto de notificação sem erros 

Se não existirem erros no formulário de notificação de exportação, é apresentada uma página 
de confirmação com uma síntese de todas as informações fornecidas, incluindo os anexos. O 
RIN correspondente e o número de versão da notificação estão disponíveis na parte superior 
do ecrã. 
 
Se for necessário corrigir alguma informação na sua notificação, clique em «Continue editing» 
[Continuar a editar] e regressará ao formulário de notificação de exportação no modo de 
edição. Prima em «Submit» [Enviar] e será apresentada a página de confirmação atualizada. 
 
Se pretender enviar à sua autoridade nacional designada uma mensagem relativa à notificação 
que será enviada, utilize a caixa de mensagens na parte inferior da página de resumo (máximo 
de 500 carateres).  
 
Clique em «Submit notification to DNA» [Enviar notificação à AND] para ser encaminhado para 
a página de envio bem-sucedido (Figura 35). 
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Figura 35: Ecrã Envio bem-sucedido 

 

6.2 Projeto de notificação incompleto 

Caso existam erros no formulário de notificação, as secções e os campos incorretos são 
realçados a vermelho com mensagens de erro específicas (Figura 36).  

 

 Os campos da notificação de exportação não são verificados automaticamente 
mudando de separador. O ePIC voltará a verificar o conteúdo dos campos quando 
clicar em «Save» [Guardar], «Save & Close» [Guardar e fechar] ou «Submit» 
[Enviar]. Assim, qualquer campo corrigido apresentará a mensagem de erro até 
que seja acionada uma nova validação. 
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Figura 36: Erros apresentados numa notificação incompleta 

 
Depois de corrigir todos os erros no formulário, prima «Submit» [Enviar] e será apresentada a 
página de confirmação (Figura 35). 
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7. Reenviar notificações de exportação 

Uma notificação enviada pode ser devolvida ao exportador para ser corrigida, caso a 
autoridade nacional designada ou a ECHA identifiquem informações incorretas/em falta ou se a 
ficha de dados de segurança não for a adequada. Neste caso, o estado da notificação será 
«Pending resubmission» [Pendente de reenvio].  
 
Pode aceder a estas notificações a partir do menu «Search & View» [Pesquisar e ver] ou do 
mosaico «Notifications pending resubmission» [Notificações pendentes de reenvio] na página 
inicial (Figura 37). 

Figura 37: Notificações pendentes de reenvio 

 

7.1 Aceder a mensagens associadas a uma notificação de exportação 

Quando uma autoridade (AND ou ECHA) solicita mais alterações a uma notificação de 
exportação, inclui sempre uma mensagem com a descrição das lacunas da notificação. Pode 
aceder a esta mensagem de duas formas:  
 

• Clique no ícone de mensagem na coluna «Action» [Ação] na lista de resultados de 
pesquisa (Figura 38), depois de filtrar as notificações por «Pending resubmission» 
[Pendente de reenvio]. 

Figura 38: Coluna «Actions» [Ações] mostrando a presença de uma mensagem das 
autoridades 
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• Para aceder às mensagens, abra a notificação e selecione «Message history» [Histórico 
de mensagens] (Figura 39) no menu pendente «View» [Ver].  

 
Figura 39: Opção Ver histórico de mensagens 

 

7.2 Reenvio de notificação 

Depois de filtrar as notificações por «Pending resubmission» [Pendente de reenvio] na secção 
«Search & View» [Pesquisar e ver], clique no RIN para abrir a notificação no modo de edição. 
Faça as correções necessárias e reenvie a notificação conforme descrito no capítulo 5.1, 
Notificação de exportação para um produto químico  

7.3 Eliminação de uma notificação de exportação «pendente» da lista 
de tarefas 

Se for necessário fazer muitas alterações à notificação de exportação (p. ex., se for necessário 
alterar o produto químico referenciado), é necessária uma nova notificação. 

A notificação original permanecerá na lista de tarefas até que a «oculte». Para ocultar uma 
notificação, abra-a na página principal através do mosaico «Notifications pending re-
submission» [Notificações pendentes de reenvio] e clique no respetivo RIN. Selecione «Hide 
notification» [Ocultar notificação] no menu pendente «Actions» [Ações], no canto superior 
direito (Figura 40). 

Figura 40: Ocultar uma notificação de exportação pendente 

 

 Não é possível anular a ocultação de uma notificação de exportação depois de ter 
sido ocultada. 
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8. Duplicar notificações 

Todas as notificações de exportação podem ser duplicadas (p. ex., se necessitar de reenviar a 
mesma notificação de anos anteriores), independentemente do seu estado final. 
 
Para procurar a notificação de exportação, selecione a opção «Search & View» [Pesquisar e 
ver] (Figura 41) no menu principal. 
 
Figura 41: Pesquisar e ver uma notificação de exportação 

 
 
Efetue a pesquisa com os critérios pertinentes (p. ex. RIN/ Produto químico/País importador) e 
clique no RIN da notificação que pretende duplicar (Figura 42). 
 
Figura 42: Ver notificação  

 
 
A notificação será aberta no modo só de leitura. Selecione «Create duplicate (new)» [Criar 
duplicado (novo)] no menu pendente «Actions» [Ações], no canto superior direito da página 
(Figura 43). 
 
Figura 43: Menu Ações 

 
 
Será apresentado um aviso a lembrá-lo de que deve verificar os dados contidos na notificação 
(Figura 44). 
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Figura 44: Aviso de notificação duplicada 

 
 
Para prosseguir, tem de aceitar a mensagem, clicando em «OK». 
 
O sistema cria uma nova notificação de exportação com base nos dados da notificação original. 
No entanto, as secções 3.1 (Expected date of export [Dados esperados da exportação]) e 6.2 
(The final regulatory action [A medida regulamentar final]) estão vazias e sublinhadas a 
vermelho. Estes campos devem ser preenchidos manualmente (consulte os capítulos 5.1.2 e 
5.1.5 para obter orientações). Deve igualmente verificar se as informações do importador e o 
montante esperado (que foram copiados da notificação original) ainda são aplicáveis. Se não 
forem, pode editá-los. Depois de fornecer/editar as informações necessárias, clique no botão 
verde «Submit» [Enviar], na secção superior, para enviar a notificação. 
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9. RIN especial 

9.1 Criar um pedido de RIN especial 

Se pretender exportar: 

a) um produto químico constante do anexo I ou do anexo V para fins de investigação e 
análise em quantidades iguais ou inferiores a 10 kg por ano e por país importador;  

b) um produto químico enumerado no anexo I, parte 3, e tiver sido publicada uma 
decisão positiva importante na última circular do PIC; 

c) se o país importador tiver renunciado ao seu direito de receber uma notificação de 
exportação para este ou todos os produtos químicos; 

é necessário um RIN especial para fins administrativos. 

Depois de aprovado pela sua autoridade nacional designada, o RIN especial permitirá o 
tratamento aduaneiro da exportação sem que seja necessária uma notificação de exportação 
integral.  

Para criar um pedido de RIN especial, clique em «Request for chemical/mixture/article» 
[Pedido para produto químico/mistura/artigo] (dependendo da sua necessidade) na secção 
«Special RIN Request» [Pedido de RIN especial] do menu principal. 

9.1.1 Informação relativa à exportação 
Os campos obrigatórios estão assinalados com um asterisco (*). 

«Importing country*» [País importador*]: selecione o país importador na lista pendente. 

«Chemical to be exported*» [Produto químico a exportar*]: caso a exportação em 
causa se destine a uma única substância enumerada no anexo I, selecione-a na lista pendente. 
Se a exportação se destinar a uma substância incluída numa entrada de grupo, tem de 
especificar o número CAS da substância no campo dedicado. 

 Se o seu pedido de RIN especial se destinar a uma mistura ou a um artigo, a lista 
pendente conterá os artigos/misturas que criou. 

 

«CAS #» [N.º CAS]: se tiver selecionado um produto químico na lista pendente, este campo 
é preenchido automaticamente e não pode ser editado. Se o produto químico estiver incluído 
numa entrada de grupo, tem de especificar o respetivo número CAS neste campo. Se o 
número CAS for reconhecido pelo ePIC, os campos da secção «Chemical information» 
[Informação química] serão preenchidos automaticamente. Se o sistema não reconhecer o 
número CAS, deve contactar o serviço de assistência da ECHA.  

«CUS code» [Código CUS]: indique o código CUS do produto químico ou da mistura. A 
indicação do código CUS é obrigatória para todas as substâncias e misturas às quais foi 
atribuído um código CUS. 

«Expected date of export*» [Data prevista de exportação*]: selecione a data prevista 
de exportação no calendário. 

«Intended use*» [Utilização pretendida*]: selecione a categoria de utilização pretendida 
para o produto químico no país importador.  
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«Intended use details*» [Detalhes da utilização pretendida*]: se for possível, forneça 
informações adicionais sobre a utilização pretendida no país importador. 

«Expected amount (per year)*» [Quantidade prevista (por ano)*]: selecione a unidade 
(kg/l) e introduza a quantidade prevista a exportar.  

«Importer name, address, telephone, fax and email*» [Nome, endereço, telefone, 
fax e e-mail do importador*]: indique o nome, o endereço e as informações de contacto do 
importador. Para introduzir as informações de contacto do importador, clique no botão «Add 
importer» [Adicionar importador], adicione as informações e guarde-as.  

 Se estiver a exportar a mesma substância ao abrigo do mesmo RIN especial para 
vários importadores no mesmo país, pode repetir os passos acima se pretender 
incluir todos os importadores no seu pedido. 

 

 As informações relativas ao exportador são preenchidas automaticamente a partir 
do módulo «Contas ECHA». Pode alterar as informações relativas ao telefone, fax e 
correio eletrónico, se pretender mencionar um contacto/pessoa específicos para 
este pedido de RIN especial. O endereço da Parte só pode ser modificado 
centralmente (por um utilizador que também seja gestor do módulo «Contas 
ECHA») através da ligação disponível. 

 
Depois de preencher todos os campos necessários, clique no botão «Next section» [Secção 
seguinte]. 

9.1.2 Anexos 
Utilize este separador para anexar os documentos de apoio pertinentes. Selecione o idioma do 
documento e, depois, clique em «Browse» [Pesquisar] para localizar o ficheiro no seu 
computador. 

Escreva o código de segurança ou, se o código não for facilmente legível, solicite um novo e 
prima «Upload» [Carregar]. 
 
Depois de preencher todos os campos necessários e anexar os documentos pertinentes, clique 
em «Submit» [Enviar] para encaminhar o pedido para a sua autoridade nacional designada.  
 
9.1.3 RIN especiais para exportações que não se destinem a fins de 
investigação e análise  
Os pedidos de RIN especial também são utilizados nos cenários seguintes: 

- Um país importador renunciou ao seu direito de receber notificações de exportação para 
um produto químico específico (exportado como substância ou contido num 
artigo/mistura) ou em conjunto. Esta informação é-lhe fornecida na secção «Importing 
country info» [Informação do país importador] do ePIC. 

- O produto químico (exportado como substância ou incluído num artigo/mistura) está 
enumerado no anexo I, partes 1 e 3, do Regulamento PIC, e o país importador faz parte 
da Convenção de Roterdão E forneceu uma resposta de importação positiva na última 
circular do PIC. 

Caso a exportação se enquadre num dos cenários acima mencionados, deverá, aquando do 
envio (e depois de rever todas as informações introduzidas), efetuar uma declaração na parte 
inferior da página de confirmação. 



  Data de publicação: Outubro de 2015 43 

 

Annankatu 18, P.O. Box 400, FI-00121 Helsínquia, Finlândia | Tel. +358 9 686180 | Fax +358 9 68618210 | echa.europa.eu 

Para o cenário «A», o utilizador apenas poderá selecionar uma opção, enquanto para o cenário 
«B» terá de selecionar a declaração pertinente entre duas declarações possíveis (Figura 45).  

Figura 45: Declaração relativa à aplicabilidade de um pedido de RIN especial 

 

 O procedimento de declaração só é aplicável se a utilização pretendida for 
«Research and analysis» [Investigação e análise] com quantidades previstas 
superiores a 10 kg/l ou se a utilização pretendida for diferente de «Research and 
analysis» [Investigação e análise]. 

9.2 Pedido de RIN especial em grupo 

Esta extensão do pedido de RIN especial está disponível para os seguintes casos: 

• um grupo (grande número) de produtos químicos vai ser exportado para um ou vários 
países 

• um produto químico vai ser exportado para vários países 

Todas as exportações devem satisfazer individualmente as condições aplicáveis a um pedido 
de RIN especial. Embora o utilizador efetue apenas um envio, o ePIC dividirá os pedidos e 
gerará um RIN para cada país importador. A autoridade nacional designada reserva-se o 
direito de recusar o pedido de grupo e solicitar ao utilizador que envie vários pedidos de RIN 
especial. 

 Esta funcionalidade pode ser utilizada para a exportação de produtos químicos 
constantes do anexo I ou de produtos químicos constantes do anexo V em 
quantidades inferiores a 10 kg para fins de investigação e análise. Tenha em 
atenção que os produtos químicos constantes dos anexos I e V não podem ser 
enviados em conjunto: devem ser efetuados envios separados para os produtos 
químicos enumerados em cada anexo. 
 

Para começar, clique na ligação «Bulk request» [Pedido em grupo] na secção «Special RIN 
Request» [Pedido de RIN especial] do menu principal. 

9.2.1 Informação relativa à exportação 
Forneça informações sobre o ano previsto da exportação, selecionando o valor correto numa 
lista pendente. 

Selecione o(s) país(es) para os quais pretende exportar e adicione-o(s) à lista de «Importing 
countries» [Países importadores], clicando na seta voltada para a direita entre as duas 
colunas. 
 

 Para selecionar vários países, prima o botão «Ctrl» no teclado enquanto seleciona 
os países. 

 

 As informações relativas ao exportador são preenchidas automaticamente a partir 
do módulo «Contas ECHA». Pode alterar as informações relativas ao telefone, fax e 
e-mail, se pretender mencionar um contacto/pessoa específicos nesta notificação 
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de exportação. As informações da Parte só podem ser modificadas centralmente 
(por um utilizador que também seja gestor do módulo de Contas ECHA) através da 
ligação disponível. 

 
Depois de preencher todos os campos necessários, clique no botão «Next section» [Secção 
seguinte]. 

9.2.2 Anexos 
Carregue dois documentos com o seu pedido de RIN especial. O primeiro («Bulk Special RIN 
request» [Pedido de RIN especial em grupo]) é o ficheiro que contém todas as informações 
pertinentes sobre o seu pedido e o segundo («Information to Customs» [Informação para as 
autoridades aduaneiras]) deve ser um subconjunto de informações do primeiro documento 
sem as informações confidenciais.  

A sua autoridade nacional designada utilizará o primeiro documento, enquanto o segundo 
permitirá às autoridades aduaneiras verificar a sua expedição.  

Se pretender, pode carregar outros documentos de apoio ao seu pedido. 

 O formato do ficheiro «Bulk Special RIN Request» [Pedido de RIN especial em 
grupo] é determinado pela sua autoridade nacional designada. 

 
Indique o código de segurança ou solicite um novo, caso este não seja facilmente legível, e 
prima o botão «Upload» [Carregar]. 
 
Depois de preencher todos os campos necessários e anexar todos os documentos pertinentes, 
clique em «Submit» [Enviar] para encaminhar o pedido para a sua autoridade nacional 
designada. 

9.3 Isenção em situação de emergência 

Caso a exportação de um produto químico esteja relacionada com uma situação de 
emergência2 em que um atraso possa colocar em perigo a saúde pública ou o ambiente, o 
exportador pode solicitar a isenção de determinadas obrigações (p. ex., envio da notificação de 
exportação e fornecimento do consentimento prévio com um mínimo de 35 dias de 
antecedência). 

 O pedido de um RIN especial para uma exportação de emergência é muito idêntico 
à criação de uma notificação de exportação comum. Neste capítulo, serão 
indicadas as diferenças. Para todos os outros passos, consulte o capítulo 5.1. 

9.3.1 Secção 3 – Informação relativa à importação 
Selecione a caixa de verificação «Emergency Situation (in accordance with Article 8(5))» 
[Situação de emergência (em conformidade com o artigo 8.º, n.º 5)] para que o campo de 
justificação por baixo da mesma fique disponível. A apresentação de uma justificação para a 
situação de emergência é obrigatória para obter o RIN especial, necessário para este tipo de 
exportação. 
 

                                           
 
2 Pode ser concedida uma isenção da obrigação de notificar no prazo de 35 dias antes da data prevista de exportação, 
mediante pedido fundamentado do exportador, da Parte importadora ou de outro país importador, nos casos em que a 
exportação do produto químico esteja relacionada com uma situação de emergência em que um atraso possa colocar 
em perigo a saúde pública ou o ambiente na Parte importadora ou noutro país importador.  (Artigo 8.º, n.º 5, do 
Regulamento (UE) n.º 649/2012) 
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9.3.2 Anexos 
Além de uma ficha de dados de segurança, deve ser anexado um documento com o tipo 
«Emergency Situation» [Situação de emergência]. Este documento deve explicar 
pormenorizadamente a natureza da situação de emergência. 
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10. Manter um registo das suas notificações 

10.1 Histórico de eventos 

Utilizando a funcionalidade de histórico de eventos, os exportadores podem acompanhar a 
evolução da notificação de exportação enviada, bem como das tarefas associadas. O relatório 
apresentará informações sobre os eventos relacionados com a notificação, tais como: 

• Envio 

• Reenvio, 

• Verificação da autoridade nacional designada, 

• Validação da ECHA, 

• Ativação da ECHA, 

• Pedido de consentimento explícito da autoridade nacional designada, 

• Pedido de isenção, 

• Registo, pela autoridade nacional designada, de uma resposta a um pedido de 
consentimento explícito. 

Para aceder ao histórico de eventos de uma notificação de exportação, procure a notificação, 
abra-a e selecione «Event history» [Histórico de eventos] no menu pendente «View» [Ver], no 
campo superior direito (Figura 46). 

Figura 46: Ligação para «Event history» [Histórico de eventos] 

 

10.2 Histórico de envio 

Utilizando a funcionalidade «Submission history» [Histórico de envio], o exportador pode 
aceder e comparar diferentes versões da mesma notificação de exportação (se disponível).  

Se a autoridade nacional designada ou a ECHA solicitarem informações suplementares após o 
envio da notificação, o exportador tem a possibilidade de continuar a trabalhar na notificação 
enviada anteriormente. Logo que o exportador reenvie a notificação, o novo envio será 
apresentado no «Submission history» [Histórico de envio] juntamente com as versões 
anteriores da notificação de exportação e eventuais anexos. 
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Para aceder ao «Submission history» [Histórico de envio] de uma notificação de exportação, 
procure a notificação, abra-a e selecione «Submission history» [Histórico de envio] no menu 
pendente «View» [Ver], no campo superior direito (Figura 47). 

Figura 47: Ligação para «Submission history» [Histórico de envio] 

 

10.3 Mensagens de correio eletrónico de alerta 

O utilizador tem a possibilidade de solicitar que as mensagens de correio eletrónico sejam 
enviadas para um endereço predefinido sempre que ocorrerem eventos específicos no sistema. 
A título de exemplo, referem-se os seguintes eventos: 

• Verificações de uma notificação de exportação/um pedido de RIN especial por parte da 
autoridade nacional designada 

• Validação/ativação de uma notificação de exportação pela ECHA 

• Verificação de proposta de isenção 

• Ativação/desativação de RIN na sequência de uma resposta de consentimento explícito 

• Alteração do estado do RIN 

• Aproximação do prazo de envio do relatório do artigo 10.º 

Para ativar as funcionalidades de correio eletrónico, o utilizador deve abrir a secção «Manage 
e-mail notifications» [Gerir notificações por correio eletrónico], clicando na seta junto ao nome 
do utilizador que é apresentado no canto superior direito da aplicação (Figura 48). 

Figura 48: Definições de notificação por correio eletrónico 

 
Se já estiver definida uma pessoa de contacto para a organização, bastará ativar as 
notificações por correio eletrónico para os utilizadores selecionados, selecionando as caixas de 
verificação «Receive notifications» [Receber notificações] na coluna «Actions» [Ações] 
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(Figura 49). 

Figura 49: Ativar notificações por correio eletrónico 

A menos que já exista uma pessoa de contacto no sistema, é necessário indicar uma para 
ativar a funcionalidade de alerta por correio eletrónico. Clique no botão «Add contact» 
[Adicionar contacto] (Figura 50) e selecione o ícone de lápis na coluna «Actions» [Ações]. 

Figura 50: Adicionar nova pessoa de contacto 

 

Depois de indicar as informações da nova pessoa de contacto, clique no ícone de verificação, 
na coluna «Actions» [Ações] para finalizar a adição do contacto (Figura 51). 

Figura 51: Guardar as informações do novo contacto 
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11. Isenções 

11.1 Pedido de isenção na ausência de resposta a um pedido de 
consentimento explícito (isenção padrão) 

Para a exportação de produtos químicos/misturas enumerados no anexo I, parte 2 ou 3, é 
necessário o consentimento explícito positivo da autoridade nacional designada do país 
importador. 

Se o país importador não tiver respondido no prazo de 60 dias a contar da data em que a 
autoridade nacional designada da UE solicitou um consentimento explícito, o exportador pode 
propor uma isenção das obrigações de consentimento explícito. Para o efeito, deve apresentar 
documentação comprovativa de que a substância está licenciada, registada ou autorizada no 
país importador.  

11.1.1 Propor uma isenção padrão 
Para propor uma isenção, localize a notificação de exportação, usando a funcionalidade 
«Search & View» [Pesquisar e ver] e abra-a, clicando no RIN na primeira coluna da lista de 
resultados de pesquisa. 

A funcionalidade «Propose waiver» [Propor isenção] está disponível no menu pendente 
«Action», no canto superior direito da página (Figura 52). 

Figura 52: Ligação para «Propose waiver» [Propor isenção] 

 

A documentação de apoio ao pedido de isenção deve ser carregada para o ePIC. Selecione o 
idioma do documento e clique em «Browse» [Pesquisar] para localizar o(s) ficheiro(s) 
pertinente(s) no seu computador. 

 Deve ser anexado, pelo menos, um documento justificativo da proposta de 
isenção. Se o documento não estiver em inglês, francês ou espanhol, deve 
igualmente ser fornecida uma tradução para uma destas línguas.  

 
Escreva o código de segurança ou solicite um novo, caso este não seja facilmente legível, e 
prima o botão «Upload» [Carregar]. 
 
Selecione a declaração legal adequada e clique em «Submit» [Submeter].  
 

 Uma vez que as isenções comuns só podem ser solicitadas 60 dias após o pedido 
inicial de consentimento explícito, verifique as datas dos pedidos, utilizando a 
secção «Event history» [Histórico de eventos]. 
 

Se o formulário de proposta de isenção não contiver erros, é apresentada uma página de 
confirmação. Reveja as informações fornecidas antes de enviar. 
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Opcionalmente, pode enviar uma mensagem à sua autoridade nacional designada (máximo de 
500 carateres) 
 
Clique em «Submit to DNA» [Enviar à AND] para propor a derrogação à sua autoridade 
nacional designada. 
 
11.2 Isenção da OCDE 

Se o produto químico notificado estiver enumerado no anexo I, parte 2, e o país importador for 
membro da OCDE, pode apresentar uma proposta de isenção do consentimento explícito 
imediatamente depois de enviar uma notificação de exportação e de obter um RIN. O 
exportador deve apresentar documentação comprovativa de que o produto químico está 
licenciado, registado ou autorizado nesse país da OCDE.  
 
11.2.1 Propor isenção 
Procure a notificação pertinente e clique no RIN para visualizá-la.  
No menu pendente «Actions» [Ações], selecione «Propose waiver» [Propor isenção] 
(Figura 53).  
 

Figura 53: Opção Propor isenção 

 
 
É apresentado um formulário preenchido automaticamente.  
 
Selecione o idioma do documento e procure o ficheiro a carregar. Deve ser anexado, pelo 
menos, um documento justificativo da proposta de isenção. 
 
Escreva o código de segurança ou solicite um novo, caso este não seja facilmente legível, e 
prima o botão «Upload» [Carregar]. 
 
Selecione a declaração legal adequada e clique em «Submit» [Submeter]. Se o formulário de 
proposta de isenção não contiver erros, é apresentada uma página de confirmação para 
resumir a informação fornecida, incluindo os anexos. 
 
Opcionalmente, pode enviar uma mensagem à sua autoridade nacional designada (máximo de 
500 carateres) 
 
A opção «Continue editing» [Continuar a editar] reencaminha-o para o formulário da proposta 
de isenção. 
 
A opção «Submit to DNA» [Enviar à AND] guarda a proposta e envia-a à sua autoridade 
nacional designada. É apresentada uma página de envio bem-sucedido e é gerado o «Waiver 
Request ID» [ID do pedido de isenção]. 
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 Não é possível guardar temporariamente o formulário de proposta de isenção; tem 
de ser preenchido e enviado de uma vez. 
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12. Comunicação de informação nos termos do artigo 10.º 
através do ePIC 

O ePIC disponibiliza aos utilizadores da indústria um formulário Web para que possam cumprir 
as suas obrigações nos termos do artigo 10.º do Regulamento PIC e fornecer informações 
sobre as exportações e importações de produtos químicos sujeitos a regulamentação 
(juntamente com as quantidades exatas) que tiveram lugar durante o ano de calendário 
anterior. O relatório relativo às exportações é, tanto quanto possível, preenchido 
automaticamente pelo ePIC quando os dados estão disponíveis no sistema. 

12.1  Gerar o relatório do artigo 10.º 

O relatório é gerado automaticamente para todas as empresas que enviaram, pelo menos, 
uma notificação de exportação (incluindo RIN especiais não abrangidos pelo disposto no artigo 
2.º, n.º 3) durante o período de comunicação de informação em causa. A geração automática 
do relatório tem lugar no dia 1 de janeiro subsequente ao período de comunicação de 
informação (p. ex., se o período de comunicação for o ano de 2015, o relatório é gerado em 1 
de janeiro de 2016). 

Se o exportador não tiver enviado uma notificação de exportação durante o ano anterior ou a 
empresa apenas tiver efetuado importações durante o período de comunicação de informação, 
o relatório não será gerado automaticamente, uma vez que o sistema não disporá de 
informações relativas a essas exportações/importações. Para poder enviar o relatório do artigo 
10.º, o utilizador deve gerá-lo manualmente. Para gerar o relatório, selecione «Create report 
on exports» [Criar relatório sobre exportações] ou «Create report on imports» [Criar relatório 
sobre importações] na secção «Article 10 reports» [Relatórios do artigo 10.º] do menu 
principal. 

 Só é possível gerar um relatório por tipo de relatório e por ano de calendário. Se o 
sistema já tiver gerado um relatório automaticamente, a funcionalidade de geração 
manual é desativada. 

12.2  Verificar e concluir o relatório do artigo 10.º sobre exportações 

Uma vez gerado o relatório, o utilizador pode aceder-lhe através da opção «Search & View» 
[Pesquisar e ver] na secção «Article 10 reports» [Relatórios do artigo 10.º] do menu principal. 
Para abrir o relatório, clique no ano do relatório na coluna «Year» [Ano] do quadro 
apresentado. 

O relatório é constituído por três partes: 

• O resumo do relatório (Figura 54), onde são apresentados o nome da empresa, o tipo 
de relatório e o ano do relatório. 

Figura 54: Relatório do artigo 10.º - Resumo do relatório 

 

• A segunda secção apresenta as informações da empresa (Figura 55). Estas informações 
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só podem ser editadas através das definições da sua conta ECHA, com exceção da 
pessoa de contacto. 

Figura 55: Relatório do artigo 10.º - Informações da empresa 

 

• A terceira parte apresenta as informações pormenorizadas relativas às exportações que 
tiveram lugar durante o período de comunicação de informação (Figura 56) – tal como 
foram extraídas das notificações de exportação pertinentes. 

Figura 56: Relatório do artigo 10.º - Informações relativas às exportações 

 

12.2.1 Informações relativas às exportações 
O quadro que apresenta as informações relativas às exportações notificadas contém as 
informações seguintes: 

• «Annex I entry» [Entrada do anexo I]: nome da substância/do grupo enumerado 
no anexo do regulamento. Esta informação está preenchida automaticamente para as 
exportações notificadas e não pode ser editada. 

• «Annex I element» [Elemento do anexo I]: se a entrada do anexo I for referente a 
um grupo de substâncias, o utilizador terá de selecionar o elemento específico que foi 
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exportado. O utilizador deve selecionar a substância adequada numa lista pendente. 
Esta informação é obrigatória e o utilizador deve introduzi-la manualmente. Caso o 
produto químico exato já tenha sido especificado durante a criação da notificação de 
exportação, a informação é preenchida automaticamente e não pode ser modificada. 

• «Importing country» [País importador]: país para o qual a substância/a mistura/o 
artigo foi exportada/o. Esta informação é preenchida automaticamente e não pode ser 
editada. 

• «Quantity» [Quantidade]: a quantidade da substância exportada para o país 
específico, indicada em kg. Esta informação é obrigatória e o utilizador deve introduzi-la 
manualmente. 

 Tenha atenção que, no caso das misturas e dos artigos, a quantidade a indicar é a 
do produto químico do anexo I contido no artigo/mistura e não a quantidade da 
mistura/do artigo como um todo. 

• «Art 14(7):» [Art. 14.º, n.º 7]: se a substância exportada estiver enumerada no 
anexo I, parte 2 ou 3, e a exportação tiver sido ativada com base numa isenção 
aprovada, esta caixa de verificação está selecionada automaticamente e não é editável. 

• «Importers» [Importadores]: o utilizador deve introduzir todos os importadores, no 
país importador, para os quais tenha exportado a substância em causa durante o 
período de comunicação. Para adicionar os importadores pretendidos, clique no ícone de 
lápis e, na lista apresentada, assinale as respetivas caixas de verificação na coluna 
«Actions» [Ações]. Quando terminar a seleção, clique em «Update report (back)» 
[Atualizar relatório (voltar)] para regressar ao relatório do artigo 10.º. Se o importador 
pretendido não constar na lista, siga as instruções fornecidas no capítulo 5.1.2.1 para 
adicionar uma nova empresa.  

• «RIN»: os números de identificação de referência da(s) notificação(ões) de exportação 
para a substância especificada serão apresentados nesta coluna. Esta informação é 
preenchida automaticamente e não pode ser editada. Se o exportador optar por gerar 
manualmente um relatório, não será possível adicionar o RIN ao mesmo. 

• «Delete» [Eliminar]: só podem ser eliminadas do relatório exportações introduzidas 
manualmente. Para isso, selecione a caixa de verificação nesta coluna e clique em 
«Save» [Guardar]. 

12.2.2  Introdução manual de dados sobre exportações 
Se o exportador não tiver enviado uma notificação de exportação durante o ano de calendário 
anterior, tem a possibilidade de adicionar manualmente ao relatório a informação relativa a 
essas exportações. 

É possível introduzir manualmente um máximo de cinco exportações, sendo disponibilizadas 
cinco linhas adicionais ao clicar no botão «Save» [Guardar]. 

Os campos indicados no capítulo 12.2.1 são todos obrigatórios, com exceção das informações 
relativas à isenção prevista no artigo 14.º, n.º 7, do Regulamento PIC e ao RIN, uma vez que 
estas não são aplicáveis às exportações codificadas manualmente. 

 Tenha em atenção que as informações relativas ao importador só podem ser 
adicionadas depois de terem sido fornecidas todas as restantes informações na 
linha relevante e de o utilizador ter guardado o formulário. O ícone de lápis para a 
edição das informações do importador fica então ativo. 
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 O relatório pode ser guardado em qualquer altura para que o utilizador volte a 
trabalhar nele posteriormente.  

12.3 Relatório do artigo 10.º sobre importações 

Os relatórios do artigo 10.º sobre importações assemelham-se aos relatórios sobre 
exportações: apresentam o resumo do relatório, as informações da empresa e informações 
detalhadas sobre as importações.  

 A geração automática do relatório só é possível para os relatórios sobre 
exportações, uma vez que as informações sobre importações não estão associadas 
a um exportador e não são armazenadas no ePIC. 

As informações sobre as importações devem ser introduzidas manualmente e no mesmo 
formato que as informações sobre as exportações, com as seguintes exceções: 

• «Exporting country» [País exportador]: o utilizador tem de selecionar o país de 
origem da substância/mistura/do artigo na lista pendente disponível. 

• «Exporters» [Exportadores]: o utilizador tem de fornecer informações sobre os 
exportadores. Esta funcionalidade trabalha em analogia com a forma como são 
fornecidas as informações sobre os importadores. Para mais informações, consulte o 
capítulo 12.2.1. 

 De modo idêntico às entradas manuais para os relatórios do artigo 10.º sobre 
exportações, as informações sobre o exportador só podem ser introduzidas depois 
de o relatório ter sido guardado. O ícone de lápis fica ativo e as informações 
podem ser editadas/adicionadas. 

12.4 Envio de relatórios do artigo 10.º (exportação/importação) 

Se o sistema não apresentar erros de validação, é apresentada uma página de confirmação 
onde o utilizador pode rever o relatório antes do envio. Quando um relatório fica concluído, o 
utilizador deve clicar em «Submit» [Enviar] para o enviar à sua autoridade nacional designada. 

 Se um utilizador receber um erro de validação ao tentar enviar o relatório, o 
sistema bloqueará o envio e apresentará uma mensagem de erro para cada campo 
onde tenha sido identificado um problema. 

Se o utilizador pretender regressar ao relatório e modificá-lo, deve clicar em «Continue 
editing» [Continuar a editar]. 

12.5 Transferir em formato Excel um relatório do artigo 10.º enviado 

O ePIC permite que os exportadores e os importadores transfiram, em formato Excel, o seu 
relatório do artigo 10.º enviado. 

Para o efeito, abra o relatório na opção «Search & view” [Pesquisar e ver] da secção «Article 
10 reports» [Relatórios do artigo 10.º] do menu principal, selecionando o ano relevante na 
coluna «Year» [Ano]. A funcionalidade «Download as excel» [Transferir no formato Excel] está 
disponível no canto superior direito do relatório, no menu «Actions» [Ações].  
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Figura 57: Transferir, no formato Excel, um relatório do artigo 10.º 
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13. Funcionalidades de pesquisa no ePIC 

Com a função de pesquisa, os exportadores podem localizar os seus projetos de notificação, 
bem como as notificações enviadas e totalmente processadas e os pedidos de RIN especial. 

13.1 Procurar notificações de exportação/pedidos de RIN especial 

Para procurar notificações de exportação ou pedidos de RIN especial, selecione o item de menu 
«Search & View» [Pesquisar e ver] na secção adequada. Algumas opções de filtragem estão 
predefinidas em conformidade com o método de acesso (p. ex., o tipo de notificação «Export 
notification» [Notificação de exportação] é selecionado automaticamente se o acesso for 
efetuado através da secção «Export Notifications» [Notificações de exportação]). 

Estão disponíveis outros campos de texto livre, listas pendentes e caixas de verificação para 
otimizar os critérios de pesquisa. 

É possível utilizar os campos seguintes para otimizar as pesquisas para obter: 

• «RIN»: uma notificação de exportação/um pedido de RIN especial específico  

• «With unread messages only» [Apenas com mensagens não lidas]: notificações 
associadas a uma mensagem não lida proveniente de um utilizador autorizado 
(autoridade nacional designada ou ECHA)  

• «Importing country» [País importador]: pesquisa específica por país 

• «CAS #» [N.º CAS]: pesquisa específica por CAS  

• «Chemical» [Produto químico]: seleção do produto químico na lista pendente 

• «Mixture» [Mistura]: seleção da mistura na lista das suas misturas 

• «Article» [Artigo]: seleção do artigo na lista dos seus artigos 

• «Search for» [Pesquisar]: para especificar se está a pesquisar pedidos de RIN 
especiais ou notificações de exportação (ou ambos) 

• «Export year:» [Ano de exportação]: é possível identificar um intervalo, 
introduzindo o ano de início no campo «From» [De] e o ano de fim no campo «To» 
[Para].  

• «Notification Status» [Estado da notificação]: seis caixas de verificação 
restringem a pesquisa a estados específicos. Se nenhuma das caixas for selecionada, a 
pesquisa será efetuada em todos os envios. 

• «RIN Status» [Estado do RIN]: para efetuar uma pesquisa com base no estado do 
RIN («Active on/Inactive on / Disabled» [Ativo em/Inativo em/Desativado]). Para as 
opções «Active on» [Ativo em] e «Inactive on» [Inativo em], terá também de indicar 
uma data. Para mais informações sobre os diversos estados de RIN, consulte o capítulo 
13.3. 

Depois de introduzir/selecionar os critérios necessários, clique no botão «Search» [Pesquisar]. 

Nos resultados de pesquisa apresentados, pode abrir a notificação/o RIN especial pretendida/o, 
clicando no respetivo RIN. 
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13.2 Procurar uma mistura ou um artigo 

Para procurar uma mistura ou um artigo já criado, selecione «Gerir misturas» ou «Gerir 
artigos» na secção «Chemicals, Mixtures & Articles» [Produtos químicos, misturas e artigos] do 
menu principal. 

«Name» [Nome]: indique o nome da mistura ou do artigo  

«Contains chemical» [Contém o produto químico]: pesquisa apenas por misturas/artigos 
que contenham o produto químico específico. 

As caixas de verificação «Mixture» [Mistura] e «Article» [Artigo] podem limitar a sua pesquisa 
a misturas ou a artigos (a pesquisa é efetuada em ambos, caso sejam assinaladas as duas 
caixas de verificação). 

Para efetuar a pesquisa, clique no botão «Search» [Pesquisar]. 

13.3 Estados de RIN 

«Active» 
[Ativo] 

O estado de um RIN torna-se ativo quando: 

• a notificação está totalmente processada; 

• a data de exportação prevista é atingida; 

• adicionalmente, para os produtos químicos enumerados no anexo I, 
partes 2 e 3, está disponível um consentimento explícito válido e 
positivo.  

Um RIN ativo fornece às autoridades aduaneiras uma indicação de que uma 
determinada exportação deve ser autorizada.  

«Inactive» 
[Inativo] 

Um RIN está inativo quando: 

• a notificação não está totalmente processada; 

• a data de exportação prevista é futura; 

• adicionalmente, para os produtos químicos enumerados no anexo I, 
partes 2 e 3, não está disponível um consentimento explícito (ou uma 
isenção) válido e positivo.  

 Quando a notificação está totalmente processada, o estado da notificação 
permanece «Inactive» [Inativo] até que a data prevista de exportação seja 
atingida, ou (no caso de produtos químicos constantes das partes 2 e 3 do 
anexo I) na data em que for recebido um consentimento explícito válido e 
positivo, se esta data for posterior. Se for apresentado apenas o texto 
«Inactive» [Inativo], a notificação não está totalmente processada ou não 
existe consentimento explícito aplicável. Se o estado estiver «Inactive» 
[Inativo], seguido de um período de tempo (p. ex., «Export allowed 
[Exportação autorizada]: 01.01.2015 – 31.12.2015), a notificação está 
totalmente processada E existe um consentimento explícito válido (se 
necessário), mas a data prevista de exportação não foi atingida. Neste caso 
particular, o RIN ficará automaticamente ativo na data prevista de 
exportação. 

«Disabled» 
[Desativado] 

Um RIN desativado implica que ou existe no sistema um consentimento 
explícito negativo do país importador para a substância/a mistura/o artigo ou 
o envio foi rejeitado pela autoridade nacional designada/ECHA. 
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«Expired» 
[Caducado] 

As notificações de exportação são válidas, no máximo, durante um ano de 
calendário. Uma vez terminada a validade, o estado é alterado para 
«Expired» [Caducado]. 

13.4 Informação específica dos países importadores 

A secção «Importing country info» [Informação do país importador] (Figura 58) contém 
informações específicas fornecidas por certos países importadores. Estas informações são de 
natureza genérica e, por conseguinte, estão disponíveis fora da lista de consentimento 
explícito. 

Figura 58: Informação do país importador 

 

Nesta secção, as informações podem ser referentes a, por exemplo: 

• Requisitos específicos a cumprir no âmbito da notificação de exportação 

• Informação sobre produtos químicos proibidos (ou categorias de produtos químicos, p. 
ex., pesticidas) 

• Informação sobre produtos químicos para os quais o país importador tenha renunciado 
ao direito de receber notificações de exportação 

• Legislação específica do país 

A informação pode ser acedida através de «Importing country info» [Informação do país 
importador] na secção «Chemicals, Mixtures & Articles» [Produtos químicos, misturas e 
artigos] do menu principal ou durante a criação de uma notificação de exportação. Neste 
último caso, se a informação estiver disponível para o país importador em causa, será 
apresentado um ícone redondo vermelho com um «i» branco junto à lista pendente 
(Figura 59).  

Figura 59: Ícone a notificar o utilizador sobre a disponibilidade de informação 
específica do país 

 



60 Manual de utilização do ePIC para a indústria   

 

Annankatu 18, P.O. Box 400, FI-00121 Helsínquia, Finlândia | Tel. +358 9 686180 | Fax +358 9 68618210 | echa.europa.eu 

 A secção «Importing country info» [Informação do país importador] contém dados 
apenas sobre um número selecionado de países. A ECHA adiciona as informações 
ao ePIC à medida que lhe são disponibilizadas. 
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